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Table 1: Cross Reference of Applicable Products

Product Name Manufacturer Part Number Device Type

Lattice Certus-NX-RT FPGA uUT24C407 RLO1

1.0 Overview

This document details the process of creating a Certus-NX-RT FPGA project using the Lattice Radiant software tools. For the
purposes of this document, create a project named led_brightness and configure the Radiant tools to include all the source
modules required for a successful build. Using this template, projects are created using (a) the preferred application source
directory structures and (b) the directory structure for the Radiant-supplied files. Figure 1 shows the block diagram of the
design, with the switches SW[3:0] controlling the duty cycle to the pwm output, which controls the brightness to LED[0];
LED[7:4] are used as heartbeat of the system.
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Figure 1: An Example Netlist View
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2.0 Creating a Design Project with Radiant Software

1. Download CreatingRadiantProject.zip from frontgrade.com.

D 2. Launch Radiant Software

3. From the File menu, select New > Project....
4. Specify the project name as led_brightness, navigate to the location of your choice and click Next, see Figure 2.
New Project X

Project Name
Enter a name for your project and specify a directory where the project data files will be stored.

Project:
Name: led_brightness|

Location: | C:/projects/Lattice/Certus-NX-RT/applications/led_brightness * | | Browse...

Project will be created at C:/projects/Lattice/Certus-NX-RT/applicationsfled_brightness/l Create subdirectory

Implementation:

Name: impl_1

Location:  C:/projects/Lattice/Certus-NX-RT/applications/led_brightness/led_brightness/impl_1

< Back Next > Cancel Help

Figure 2: Creating a Radiant Design Project
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5. Select Add Source... and click Open, see Figure 3 and Figure 4, click Next.
Import File X
T « Lattice > applications > led_brightness > src v O L Search src
Organize ~ New folder =~ [ o
“  Name i Date modified Type Size

*

T E] debounce 1/10/2022 4:25 PM Verilog File Type™ 3KB

4 b pwm 1/10/2022 4:25 PM Verilog File Type" 2KB

g pwm_led_brightness_top 1/10/2022 4:25 PM Verilog File Type” 3KB

File name: |“pwm_led_brightness_top” “debounce” “pwm"” v | -In_put_FiI;s Z‘.vh_d *.v_*.sv *.h_*.l'p: ~
Figure 3: Selecting Sources
MNew Project x
Add Source
Add HDL, constraint or other files.

Source files: Add Source...
C:fprojects/Lattice/Certus-NX-RT/applications/led_brightness/src/debounce.
C:/projects/Lattice/Certus-NX-RT/applications/led_brightness/src/pwm.v
C:/projects/Lattice/Certus-NX-RT/applications/led_brightness/src/pwm_led_brightness_top.v

Copy source to implementation source directory
Create empty constraint files
< Back Next > Cancel Help
Figure 4: Adding Sources
4350 Centennial Blvd., Colorado Springs, CO 80907 e frontgrade.com e sales@frontgrade.com Page 4 of 14



rRONTGRADC

APPLICATION NOTE

Creating Certus-NX-RT Project in Radiant Software

Version #: 1.0.0 3/18/2022
6. Select the appropriate device, click Next and choose Lattice LSE; click Next and Finish, see Figure 5.
New Project X

Select Device
Specify a target device for the project.
Select Device: Device Information:
Family: Device: Core Voltage: 1.0V
iCE40UP (iCE40 UltraPlus) ~ LFD2NX-17 Logic e 900
LFCPNX (CertusPro-NX)  LFD2NX-40 il s
LFD2NX (Certus-NX) gL =
LIFCL (CrossLink-NX) R Hodks: i
LRAM: 2
DSP (18x18 Multiplier): 56
ADC Blocks: 1
PLLs: 3
DLLs: 2
PCSs: 1
4 r

Operating Condition: Package: i -
DPHYs: 0

Commerdial -  CABGA256 - PIO Cells: 185

Performance Grade: PIO Pins: 197
9_High-Performance_1.0V -

Part Number:

LFD2NX-40-9BG256C -
Online Data Sheet for Device
< Back Next > Cancel Help
Figure 5: Selecting the FPGA Device
New Project X
Select Synthesis Tool
Spedify a synthesis tool for the implementation.
Synthesis Tools:
Synplify Pro
@ Lattice LSE
Figure 6: Selecting the Synthesis Tool
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7. Theinitial project with the provided files should look like Figure 7.

Lattice Radiant Software - Reports

file Edit View Project Tools Window Help
- I s
[ 3 u Synthesize Design

- led_brightness.
{3 LFD2NX-40-9BG256C
~ [ Strategies
[+] Area
[¥] Timing
[ strategy1
~ % impl_1 (Lattice LSE)
~ [ Input Files
[ source/impl_1/debounce
%] source/impl_1/pwm.v
[2] source/impl_1/pwm_led_brightness_top.v
= () Pre-Synthesis Constraint Files
£ Lattice LSE

29 Synplify Pro.

[ source/impl_1/impl_1.sdc
~ [ Post-Synthesis Constraint Files
[] source/impl_1/impl_1.pdc
Debug Files
> Script Files

£ Analysis Files
Dennramminn Filec
~ {1} pwm_led_brightness_top - pwm_led_brightness_top.v
i} pwm_gen(pwm_gen_inst1) - pwm.v
{} debounce(debounce_inst3) - debounce.y
{3 debounce(debounce_inst2) - debounce.v
1} debounce(debounce_inst1) - debounce:v
1} debounce(debounce._inst) - debounce.v

Q Q@@

u Place & Route Design

=
u Export Files [

D Xa 10} start Page . Reports
Reports
» | Synthesis Reports
» | Map Reports
» | Place & Route Reports
| » | Export Reports
» | Misc Reports
x

<

> prj_create -name "led_brightness” -impl "impl 1" -dev LFD2NX-40-9BG256C g
C:/projects/Lattice/Certus-NX-RT/applications/led_brightness/led_brightness/led_brightness.rdf
jects/Lattice/Certus-NX-RT/applications/led_brightness/led_brightness/source.
"C:/projects/Lattice/Certus-NX-RT/applications/led_brightness/src/debounce.v"

> prj_add_source "C:/p.
> file copy -force -

e DE

me s

Led_brightness Project Summary

3/18/2022

GOo0BEIHBSM

N

Implementation Name: impl_1 Performance Grade: 9_High-Performance_1.0V
Strategy Name Strategy Operating Condition CcoM
Part Number LFD2NX-40-98G256C Synthesis Lattice LSE
Family LFD2NX Timing Errors
Device LFD2NX-40 Project Created 2022/03/18 09:15:00
Package: CABGA256 Project Updated 2022/03/18 09:15:01
Project File: CiIprojects/Lattice/Certus-NX-RT X X |_brightness.rdf
Implementation Location Ciiprojects/l attice/Certus-NX-RT 1
Resource Usage
LUT4 0 10 Buffers: [
PFU Register 0 EBR 0
S »
"9_Hi _1.0v" - is "lse" 2 xil

mpl_1/impl_1.sde" "C:/projects/Lattic:
/projects/Lattice/Certus-NX-RT/appli

> prj_add_source "C:/projects/Lattice/Certus-NX-RT/applications/led_brightness/led_brightness/source/impl_1/debounce.v" "C:/projects/ILattic

> prj_save

»

[ e ist [E] Source Template 2] 1P Catalog Td Console E output E? Message

Figure 7: An Example of an Initial Project

8. From IP Catalog, add a PLL with the options below and name it pwm_plI3, see Figure 8 and Figure 9.

Module/IP Block Wizard X

Generate t from Module pll Version 1.5.0
This wizard will guide you through the configuration, generation and instantiation of this Module/IP. Enter the following
information to get started.

Component name:  pwm_pli3] o
Create in: C:/projects/Lattice/Certus-NX-RT/applications/led_brightness/led_brightness 'B Browse...
Next > Cancel

Figure 8: Opening the IP Catalog
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Diagram pwm_pil3 Configure pwm_pli3:
- General Optional Ports
Property Value =
Configuration Mode | Frequency 5
Enable Fractional-N Divider
pwm_p] I 3 = Enable Splendipec!rum Clock Generation
Enable User Feedback Clock
Enable PMU Wait for Lock
clkop_o Enable Internal Path Switching |C
clki_i - :
clkos_ ~ ReferenceClock
Cl.l(l:Freq:_aeru_:yml-m !10-&10! 12 "
P Enable Reference Clock Monitor
CLKFB: Feedback Mode | CLkop
= x CLKOP: Frequency Desired Value (MHz) [10 - 800] 25 il
CLKOP Tolerance (%) | 50 J
CLKOP: Enable Trim for CLKOP
CLKOS: Enable =
CLKOS: Bypass |
CLKOS: Frequency Desired Value (MHz) (6.25 - 800) | 10
c T*'me m - . 6:2."““".““""“““““-""""““"g 1
CLKOS: Static Phase Shift (Degrees) 0
CLKOS: Enable Trim for CLKOS
Figure 9: Adding a PLL from the IP Catalog
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9. Once the PLL s created, it is added to the project files, see Figure 10.

Lattice Radiant Software - Reports - o X
File Edit View Project Tools Window Help

&-&- 8 ~ Qe EEH AR CHREERRSGORESBSM
b [ cvencer FE woen | reseosn o owene | [ FSPS—

~ [ led_brightness 12 g 1) stat Page &= Reports z
n LFD2NX-40-9BG256C
+ [ Strategies = =
1] Area Reports. Led_brightness Project Summary
= Timing Implementation Name: impl_1 Performance Grade: 9_High-Performance_1.0V
- [ strategyt _ Strategy Name: Strategyt Operating Condition com
~ 7 impl_1 (Lattice LSE)
. ) Part Number LFD2NX-40-98G256C Synthesis: Lattice LSE
i InpUtEREs » () Synthesis Reports
[ source/impl_1/debounce Family: LFD2NX Timing Errors:
] source/impl_1/pwm.y
[ /el 1/ » " Map Reports Device: LFD2NX-40 Project Created 202210318 09:15:00
i._source/impl_1/pwm_led brightness_top.v
= [8) pwm_pil3/pwm_pli3ipx Package: CABGA256 Project Updated: 2022/03/18 09:15.01
»
> I RILFiles Place & Route Reports Project File Cilprojects/Lattice/Certus-NX-RT/ |t Lt |_brightness.rdf
» [ Constraint Files
Clprojects/L attice/Certus-\
» [ Testbench Files | » (3 Export Reports tocston 2
) pwm_pli3.cfg
= [ Pre-Synthesis Constraint Files Resource Usage
[ Lattice LSE ) Misc Reports 2
. LuT4 6 10 Buffers 13
=41 Synplify Pro
) source/impl. 1/impl_ 1.5 PFU Register. 137 E8R 0
w [79 Pnet.Sunthacic Conctraint Filac 2
~ 11} pwm_led_brightness_top - pwm_led_brightness_top.v. x
+ 1} pwm_pli3(pwm_plI3_inst) - pwm_pli3y
{1 pwm_gen(pwm_gen_inst1) - pwm.v
« B
8B debounce(debounceinst3) - debouncev > file copy -force -- "C:/projects/Lattice/Certus-NK-RT/applications/led_brightness/src/debounce.v" "C:/projects/Lattice/Certus-NK-RT/appli~
1} debounce(debounce._inst2) - debounce.y > prj_add_source "C:/proj /Lattice, pplications/led_bright: led bri source/impl_1/deb " "C:/proj /Lattic
{} debounce(debounce_inst1) - debounce.y 2 Iyl save: P " " & - <
> pri_add_source "C:/projects/Lattice. 5 licat led_bright: led pum_pl13/pum pll3.ipx"
1} debounce(debounce_inst) - debounce. > pri_run Synthesis -impl impl 1
>
« »
1 Fletist [ Source Tempiate (] 1P Catalog ] 7d Console & ouput £ essage

Figure 10: Looking at the Recently Added PLL IP

3.0 Compile Design using Radiant Software

3.1 Set Top Level File

10. From the Project menu, select Active Implementation > Set Top-Level Unit... and set pwm_led_brightness_top.v
as the top level file, see Figure 11.

Project Properties X

- led_brightness

B LFD2NX-40-98G256C
- 5B impl_1 Location:  attice/Certus-NX-RT/applications/led_brightness/led_brigh / e/impl_1

Name: pwm_led_brightness_top.v Category: Resource

[22) sourcefimpl_1/debouncev

= |
|L| sourcefimpl_1/pwm.v e s

E‘: isoutceﬁmp[_i /pwm_led_brightness.  Verilog Standard <inherit from implementation>

=2 f
[#] pwm_pli3/pwm_pli3.ipx Include for Synthesis and Simulation

|*<] source/impl_1/impl_1.pdc
|+] source/impl_1/impl_1.sdc
=] Area
[+] Timing
/ strategy1

'

Cancel

Figure 11: Setting a Top Level File
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11. Synthesize the design by clicking on the Synthesize Design arrow, see Figure 12.

Lattice Radiant Software - Reports
File Edit

s-E3- A

View Project Tools

Window  Help

=)

led_brightness
{8 LFD2NX-40-9BG256C
~ [ Strategies

[] Area

[ Timing

(i strategy1

impl_1 (Lattice LSE)
Input Files

[) source/impl_1/debouncey
[ source/impl_1/pwm.v
[ source/impl_1/pwm_led_brightness_top.v
~ [ pwm_pli3/pwm_pli3.ipx
> [21 RILFiles
» [ Constraint Files
» [ Testbench Files
] pwm_pli3.cfg
~ [ Pre-Synthesis Constraint Files
7 Lattice LSE
[ Synplify Pro
| source/impl_1/impl_1.sdc

v 79 Pnct-Sunthacic Constraint Files
~ 1} pwm_led_brightness_top - pwm_led_brightness_top.v
v 1 pwm_pli3(pwm _pll3_inst) - pwm_pli3y
{1 pwm_gen(pwm_gen_inst1) - pwm.v
1} debounce(debounce_inst3) - debounce.y
17} debounce(debounce_inst2) - debounce.v
{7} debounce(debounce_inst1) - debounce.v
{7} debounce(debounce_inst) - debouncey

[ File List [E] Source Template {Z] IP Catalog
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QQaa@
n Place & Route Design

2 Xa

VVVVVYV e

2E B
u Export Files [ pTkhactie Decko oS

{2 Start Page L. Reports I

Reports Led_brightness Project Summary

implementation Name: impl_1 Performance Grade: 9_High-Performance_1.0V
_ Strategy Name Strategy Operating Condition: com
) Part Number. LFD2NX-40-9BG256C Synthesis: Lattice LSE

» || Synthesis Reports
Family LFD2NX Timing Errors:

» ' Map Reports Device: LFD2NX-40 Project Created: 2022/03/18 09:15:00
Package: CABGA256 Project Updated 2022/03/18 09:15:01

»

Place & Route Reports Project File: Ci/projects/Lattice/Certus-NX-RT/ X | |_brightness.rdf

Implementation Location: Ci/projects/l attice/Certus-NX-RT/ 1

» [ | Export Reports
Resource Usage

» ! Misc Reports 9
LUT4 63 10 Buffers 13
PFU Register. 137 EBR 0

file copy -for
prj_add_source
pri_save
pri_add_source "C:/projects/Lattice/Cer
pri_run Synthesis -impl impl 1

»
-- "C:/projects/Lattice/Certus-NX-RT/applications/led_brightness/src/debounce.v" "C:/pzajects/La(:ice/Cez:us—NX-RT/agl*A
projects/Lattice/Certus-NX-RT/applications/led_brightness/led_brightness/source/impl_1/debounce.v" "C:/projects/Latti

tion

/appli

led_bright led bright pwm_pl13/pwm_pl13.ipx"

Td Console = output EY Message

Figure 12: Synthesizing the Design
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3.3 Pin Assignment (Device Constraint Editor)

12. Once the design has been synthesized, assign the pin numbers to their respective signals, see Figure 13.

[F] Device Constraint Editor

File Edit View Design Window Help

QQaaa

@®

X Q> Find Text... 1615141312110 5 8 7 6 5 4 3 2 1 i
B E
» Za ports ®)
» £F Instances(66) IO
4 )
» £ Nets -l
O 0
& 0] 5
u[0)e
3 I n
ME C
B EEED DD OO
L) (] o ] ] o ] ]
. w OIOICIOIOIOIOICIEN FURIEIC IO A
Name Group By Pin BANK IOTYPE CLAMP DIFFDRIVE  DIFFRESISTOR  DRIVE  GLITCHFILTER  HYSTERESIS ~ OPENDRAN F*
B CKi2  NA G13 1 LVCMOS... | ON NA OFF NA OoN ON OFF [
© swio) N/A 10 3 LVCMOS... | ON NA OFF NA ON ON OFF T
B swi] N/A E16 0 LVCMOS... | ON NA OFF NA OoN ON OFF L
2 swi2l N/A L 3 LVCMOS... | ON NA OFF NA oN ON OFF o
o swi) N/A R3 4 LVCMOS... | ON NA OFF NA OoN ON OFF o
- @ Output N/A N/A NA | NA N/A N/A N/A NA N/A N/A N/A N
<1 LED[O) N/A 83 2 LVCMOS... | OFF NA OFF 8 OFF NA OFF N
@ Leo[n) N/A A2 2 LVCMOS... | OFF NA OFF 8 OFF NA OFF N
< LED[2) N/A H16 2 LVCMOS... | OFF NA OFF 8 OFF NA OFF N
@ LEop) N/A B2 2 LVCMOS... | OFF NA OFF 8 OFF NA OFF N
@ LED[4] N/A H15 2 LVCMOS... | OFF NA OFF 8 OFF NA OFF N
@ LED[S) N/A H14 2 LVCMOS... | OFF NA OFF 8 OFF NA OFF N
< LEDI6) N/A H12 2 LVCMOS... | OFF NA OFF 8 OFF NA OFF N
@ LEom N/A s 2 LVCMOS... | OFF NA OFF 8 OFF NA OFF N
« 5
T~ Flter Port Pin Global 550

Figure 13: Performing Pin Assignment

3.4 Compile Design

13. Compile the design by clicking on the Run All arrow, see Figure 14.

Lattice Radiant Software - Device Constraint Editor - 8 X

File Edit View Project Design Tools Window Help
Callh @aQa@a@ "L GHEERRLSGOCEAESBSM

portries | [E Export Fles ompleted.

21 Reports [E] vevice Constraint Editor X

N

~ [ ted_brightness
8 LFD2NX-40-98G256C
~ [ Strategies
[l Area
[&=] Timing
Strategy1
pI_1 (Lattice LSE)

1514131211109 8 7 6 5 43 2 1 Al Ea

+ [E Visible Banks

I PIOs

st and Programming/Confi..
SERDES

+ [ Power Supplies

- £ Input Files ]
B A = ~
[55 s/ debiomcey Name GroupBy  Pin BANK IOTYPE  CLAMP DIFFDRVE  DIFFRESISTOR DRI
L) source/impl_1/pwm.v
[ source/impl_1/pwm_led_brightness top.v ® QK12 | NA GI3G13) 1)  LVCMOS.. ONION) |NANA) | OFF(OFF) NA(
- [ pwm_pli3/pwm_pli3.ipx © swio] N/A 110(L10) 3B) | LVCMOS... ON(ON) NANA) OFF(OFF) NA(
> [ RILFiles
B © swi N/A E16€16)  00)  LVCMOS.. ONON) NANA) | OFFOFF) NA(
» £ Constraint Files
» [ Testbench Files © swiz1 N/A LAY 3B) | LVCMOS.. ON(ON) NANA) | OFF(OFF) NA(
[ pwm_piiz.cfg  swig N/A R3R3) 44) |IVCMOS.. ON(ON) NANA) | OFF(OFF) NA(
~ [ Pre-Synthesis Constraint Files
: ~ @ output NA NA NA NA NA NA N/A N/A
£ Lattice LSE
5 synpiy Pro @ Le0) NA 83(83) 22) | IVCMOS.. | OFF(O.. |NANA) | OFF(OFF) 8®)
" source/impl_1/impl_1.sdc @ LED[T] N/A A2(A2) 2(2) |LVCMOS... OFF(O... | NANNA) OFF(OFF) 89
v 5 Dnct-unthacic Conctraint Filac
~ I3 pwm_led brightness.top - pwm_led_brightness_topy x @ L) N/A HI6H16 | 22) | LVCMOS.. OFF(O.. NANA) | OFF(OFF) ES)
+ I pwm_pli3(pwm_pii3_inst) - pwm_pli3.v S 1 enm n/A RN 21 wemosLoeen | Namia RIS aum 7|
£} pwm_gen(pwm_gen inst) - pwmy T fter = = o = "
13 debounce(debounce_inst3) - debounce. . — =
1 debounce(debounce_inst2) - debounce.v > prj_add_source "C:/projects/Lattice/ licati led_bri led t ‘pwm_pl13/pum_pll3.ipx" =9
£} debounce(debounce inst1) - debounce > {gEiieon Bypchesse cirel dupl
> prilrun PAR -impl impl 1
£ debounce(debounce.inst) - debounce i P el hali
>
« >

O Fletist [E] Source Templte 2] 1P Cataog B output £ message

Figure 14: Compiling the Design
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14. From the Tools menu, select Simulation Wizard and click Next, see Figure 15.

Lattice Radiant Software - Netlist Analyzer - 0 X
File Edit View Project Design Tools Window Help
@ Timing Constraint Editor »
=] [® -
[E] Device Consan Etcr Q@ BE oL ©BHE
[ Netiist Analyzer ) et
[ I B Export Fi x
I Physical Designer Export Fles [ fes compl
B €Co Editor ge 23 Reports [ netist Analyzer [t
LIFCL-40-9BG400C ! Tinino Anoyzer Instances(9) F
Strategies A Reveal Inserter borts(3) e
) Area %@ Reveal Analyzer/Controller ets(@)
[ Timing @ Power Calculator Tocks(6) 54(3:0) D——————— ]
) Strategyl B Programmer ebounce ot
~ % impl_1 (Lattice LSE) [E] seieditor —'%@“L
~ [ Input Files (=) Bitstream Security Settings ebounce nsc3
1] source/impl_1/debour pum_pli3_inst pwm_gen instt
= B simulation Wizard axnf o Dtenir)
[2) sourcefimpl_1/pwm.y = dabounce ins2
[£] Source Template s
- Il 13.i -
[ pwm_pli3/pwm_pli3.ip [# 1P Catalog
» [ RIL Files
S
» [ Constraint Files
™ ModelSim Lattice-Edition
» Testbench Files
B wripacy Clear Tool Memory...
~ [ Pre-Synthesis Constraint F___ Qptions..
(2 Lattice LSE i
£ Synplify Pro ¢ ~
« »
; |+ source/impl_1/impl_1.sdc 1 ; BB R et - poen_ed_brig e =
~ 13 pwm_led_brightness_top - pwm_led_brightness topyX T v @ ERROR:0 4 WARNING:24 @ INFO:3 B GroupbyID  Search 2 x
+ I} pwm_pli3(pwm_plI3_inst) - pwm_pli3v ~ Project (1 info) o
1 pwm_gen(pwm_gen_inst1) - pwm.v.
© 2049992 INFO - C/L ts-old/L 1t Lt I1/pwm_led_brightness_top.v(22,8-22,30) (VERI-1018) compiling module ‘pwm_led_brightness_top’
{3 debounce(debounce_inst3) - debounce SEE
~ Synthesis (4 warnings)
13 debounce(debounce_inst?) - debounce:v e (A marie)
R 70001944 WARNING - No master clock for generated clock create_generated_clock -name {pwm_clk} -source [get_pins {pwm_plI3_inst/Iscc_pll_inst/gen_no_refclk_mon.u_PLL.PLL_inst/REFCK}] -multiply_by 2
1 debounce(debounce.inst1) - debounce.v get_pins (pwm_pli3_inst/lscc_plLinst/gen_no_refclk_mon.u_PLLPLL inst/CLKOP }].
{1} debounce(debounce_inst) - debounce. : & " A
» 4\ 70001934 WARNING - Missing master pin for instance ‘pwm_pl3_inst/iscc_pll_inst/gen_no_refclk_mon.u_PLLPLL inst'.
~ Map (4 warnings)
[ Fleist [E] Source Template (5] 1P Catalog [] d console = output E® Message
Figure 15: Simulating the Design
15. Name the project led_brightness_sim and click Next, see Figure 16.
file Edit View Project Design Iools Window Help
1. £ ~ =1 — - &
&-E2- 8 ol Qree B nl ©NBEERR 308
sor | [l recesr i il Expor Files completed.
~ [ led_brightness 2 Xa 1) start Page L1 Reports [E8 netiist Analyzer Il
8 UFCL-40-98G400C @ | ¥ Ins Simulation Wizard ? X N
Strategies ~ | *» &= porg
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~ Project (1 info)
© 2049992 INFO - C: i i | bri .t
~ Synthesis (4 wamings)

1.1/pwm_led_brightness_top.v(22,8-22,30) (VERI-1018) compiling module ‘pwm_led_brightness_top’

» 4 70001944 WARNING - No master clock for generated clock create_generated clock -name {pwm_clk) -source [get_pins {pwm_piI3_inst/lscc_pll_inst/gen_no_refclk_mon.u_ PLLPLL inst/REFCK}] -multiply_by 2
Iget_pins (pwm_pli3_inst/lscc_pllinst/gen_no_refclk_mon.u_PLLPLL inst/CLKOP ).

» 4 70001934 WARNING - Missing master pin for instance ‘pwm_plI3_inst/Iscc_pll_inst/gen_no_refclk_mon.u_PLLPLL inst.
~ Map (4 warnings)

E output 5 Message

Td Console

Figure 16: Naming the Simulation
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16. When finished, ModelSim will open and run the simulation, see Figure 17.

™ ModelSim Lattice FPGA Edition 2021.4 = o X
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Figure 17: The ModelSim Simulation Wave View
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4.0 Program the Device with Radiant Programmer

17. From the Tools menu, select Programmer and a new window opens, see Figure 18. Once the cable is detected and
settings are set, program the device by clicking the Program Device icon @ , Figure 18.

3 Radiant Programmer - impl_1.xcf

= o X
File Edit View Run Tools Help
pall= S IR 2 @w
Enable Status Device Family Device Operation File Name File Date/Time ~ Chec| Cable Setup 8 x
1 DONE LFD2NX LFD2NX-40 Fast Configurati (e attice/Certus-NX-RT; _bri _bri impl_1/... 03/18/22..  N/A || Cable Settings =
| Detect Cable
Cable: HW-USBN-28 (FTDI) v
Fort: [FTUss-0 v
Custom port:
Programming Speed Settings
@ Use default Clock Divider
O use custom Clock Divider
TCK Divider Setting (0-30x): 1 5
/0 Settings.
2 5 @ Use default /O settings
O uUse custom Y0 settings.
755 INITN pin connected
TCK DONE pin connected
ot “E—I TRST pin connected
701 US8 HOST BULD- W [ )
oomuoDCARLE = Set TRST high
Set TRST low
o1 | oz
R JTAG_EN PROGRAMN pin connected
iSpEN pin connected
Set ispEN high v
< >
Output g8 x
INFO - Devicel LFD2NX-40: Fast Configuration A
INFO - Operation Done. Ignored errors.
INFO - Elapsed time: 00 min : 10 sec
INFO - Operation: successful.

Output | Tcl Console

Figure 18: Programming the FPGA
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Revision History

Date ‘ Revision #‘ Author H Change Description
3/18/2022 |1.0.0 JA Initial Release.

Datasheet Definitions

Definition

Advanced Datasheet Frontgrade reserves the right to make changes to any products and services described herein at any time
without notice. The product is still in the development stage and the datasheet is subject to change.
Specifications can be TBD and the part package and pinout are not final.

Preliminary Datasheet Frontgrade reserves the right to make changes to any products and services described herein at any time
without notice. The product is in the characterization stage and prototypes are available.

Datasheet Product is in production and any changes to the product and services described herein will follow a formal
customer notification process for form, fit or function changes.

Frontgrade Technologies Proprietary Information Frontgrade Technologies (Frontgrade or Company) reserves the right to make changes to any products
and services described herein at any time without notice. Consult a Frontgrade sales representative to verify that the information contained herein is
current before using the product described herein. Frontgrade does not assume any responsibility or liability arising out of the application or use of any
product or service described herein, except as expressly agreed to in writing by the Company; nor does the purchase, lease, or use of a product or service
convey a license to any patents, rights, copyrights, trademark rights, or any other intellectual property rights of the Company or any third party.
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